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Capturing Image, Recording Video & Editing 

Use handset camera to capture images and record movies. 

Capturing Images & Recording Video Clips

Select Scene, Multi Shot, etc. to capture image/video 
(fP.7-3).
Record up to an hour per clip (fP.7-9).

Editing Images

Editing images, etc. (fP.7-11). Note

・	Use a dry soft cloth to remove debris 
from camera lens cover.
・	Avoid camera shake; hold handset steady 

or put it on something stable place and 
use Self-timer to prevent objectionable 
image blur.
・	Do not expose handset to devices with 

static electricity when using camera.
・	Camera employs high precision 

technology, however, some pixels may 
seem brighter or darker than others.
・	Leaving handset in a hot place for an 

extended period before capturing/saving 
image may affect image quality.
・	Exposing lens to direct sunlight may 

affect image color.
・	When battery is low, camera may be 

unavailable.

Variety of Capturing Mode

Choose applicable mode; Multi shot, Scene, 
Panorama shot etc., according to conditions (fP.7-3).

Creating Flash®

Use Still Image in Data Folder to create Flash® (fP.7-12).
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Camera

For capturing still images, select Shooting mode: 
Normal to shoot single image and Multi shot or 
Photo combi to shoot multi-shot.
Captured images are saved to Pictures. Insert 
Memory Card to save images to Digital camera.

Using Display as Viewfinder

Still Image Viewfinder

a b c d e f

g

h

i

j

k

a Shooting mode
 : Normal

 : Scene

 : Multi shot

 : Photo combi
 : Panorama shot

Scene
 : Auto1

 : Portrait1

 : Landscape1

 : Sports1

 : Night1

 : Sunset1

Number of capture
 : 6/9 Images (six images)1

 : 6/9 Images (nine images)1

Speed

 : Speed (Fast)2

 : Speed (Normal)2

 : Speed (Slow)2

 : Speed (Manual)2

b Size (the size varies for Panorama shot)
 : 3.1 M (1536x2048)3

 : Wide 2.4 M (1232x2048)3

 : 2 M (1200x1600)3

 : Wide 1.5 M (960x1600)3

 : Wide 1.0 M (768x1280)3

 : 0.3 M (480x640)3

 : Wallpaper (240x400)

 : Mail (240x320)

c Focus
 : AF On

 : Macro

 : AF Off

d Timer

 : Off	  : 3 sec.  

 : 5 sec.	  : 10 sec.

e White balance

 : Auto	  : Daylight 

 : Incandescent	  : Fluorescent

 : Cloudy

f Battery level

g Quality
 : Superfine

 : Fine

 : Normal
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h ISO

 : Auto	  : 100

 : 200	  : 400

i Focus frame

：Matrix

：Center-weight

：Spot

j Number of remaining available shots

k Save to
 : Phone or Always ask

 : Memory Card prior or Digital 
camera prior

1Shown between shooting mode and shooting size.
2Shown between Size and Focus.
3Only when the shooting mode is set to Normal or 
Scene.

・	Pressing j shows or hides icons and current 
settings.

Shooting Mode Description

Normal

Capture still image and select 
size for purpose; attach 
images to S! Mail, save as 
Wallpaper, etc.

Scene
Suitable for capturing still 
images of night scenes and 
landscapes.

Multi shot
Press shutter once to capture 
six or nine sequential images.

Photo combi

Capture sequential images 
manually. Select Frame to 
automatically combine the 
images into one image.

Panorama shot

Ideal for landscapes. 
Capture up to six images to 
automatically composite them 
into a single panoramic image.
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Single Shot

Press i Set Shooting Mode
 and press u(Back)

Save automatically or
manually depending on 

Auto save settings (fP.14-24)

Press f(           )

・	 Adjusting size and brightness are available for still images.

・	 Attach captured image to message (fP.7-13).

・	 Captured images are saved to Pictures. Insert Memory Card and set save location to Digital Camera folder to save images to Digital camera.

・	 When Focus is set to AF On, Auto Focus is available; subject in the center of AF frame is automatically focused on (white). Press f ( ) to focus on. Frame 
turns green when image is in focus.
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Normal

a	f → Camera → Camera
・	Adjust settings before capturing as required 

(fP.7-13).

b	Frame image in Viewfinder
・	Use r / n / b to zoom in/out.

・	Use g to adjust brightness.

c	f ( )
・	When Focus is set to AF On, a subject is 

automatically focused on.

・	Images are saved automatically.

・	Set Auto save to Off to save manually 
(fP.14-21).

Scene

a	f → Camera → Camera

b	i → Scene

c	Scene → Select a scene → u 
(Back)
・	Adjust settings before capturing as required 

(fP.7-13).

・	Macro, ISO, Exposure metering and Effect 
are not available for Scene.

・	To close the menu, press u (Back).

d	Frame image in Viewfinder
・	Use r / n / b to zoom in/out.

・	Use g to adjust brightness.

e	f ( )
・	When Focus is set to AF On, a subject is 

automatically focused on.

・	Images are saved automatically.

・	Set Auto save to Off to save manually 
(fP.14-21).

 

Multi Shot

a	f → Camera → Camera

b	i → Multi shot

c	Number of capture → Select image 
count

d	Speed → Fast, Normal, Slow or 
Manual → u (Back)
・	Adjust settings before capturing as required 

(fP.7-13).

・	Face Link is not available for Multi shot.

・	To close the menu, press u (Back).

e	Frame image in Viewfinder
・	Use r / n / b to zoom in/out.

・	Use g to adjust brightness.

f	f ( )
・	Images are saved automatically when 

capturing of images is over.

・	Set Auto save to Off to save manually 
(fP.14-21).

・	If Speed is set to Manual, repeat f. 
Press u (Stop) and save the images. To 
redo, press c.

・	When Auto save is Off, all images captured using 
Multi shot appear. After f, select images to save 
→ Press u (Save).
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Photo Combination

a	f → Camera → Camera

b	i → Photo combi

c	Style → Select a style
・	Adjust settings before capturing as required 

(fP.7-13).

・	Face Link is not available for Photo 
Combination.

・	To close the menu, press u (Back).

d	Frame image in Viewfinder → 
Apply selected frame and press f 
( )
・	Use r / n / b to zoom in/out.

・	Use g to adjust brightness.

e	Repeat d to capture images
・	To redo, press c.

・	Images are saved automatically when 
capturing images ends.

・	Set Auto save to Off to save manually 
(fP.14-21).

Panorama Shot

a	f → Camera → Camera

b	i → Panorama shot
・	Viewfinder appears in Landscape.

・	Adjust settings before capturing as required 
(fP.7-13).

・	Face Link is not available for Panorama 
shot.

・	To close the menu, press u (Back).

c	Frame image in Viewfinder
・	Use r / n / b to zoom in/out in 

Landscape view.

・	Use g to adjust brightness in Landscape 
view

d	f ( )

e	Move handset to capture an image 
(vertically or horizontally) → 
Adjust small white border inside 
big black border to automatically 
capture image

f	Repeat e to capture range
・	To create panorama image while capturing 

images, press u (Stop).

・	To redo, press c.

・	Alternatively, capturing six images 
automatically ends capturing.

・	Set Auto save to Off to save manually 
(fP.14-21).

・	Panorama images are created and saved 
automatically. Depending on the number 
of images to be captured, processing may 
take time.

・	Move handset slowly to capture panoramic image.
・	Panorama is ideal for capturing landscapes. Stand 

at least ten meters from subject. If too close 
panoramic image creation may fail.
・	Low light or high contrast may hinder panoramic 

image creation.
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Viewing Captured Images (Quick Play)

a	f → Camera → Camera → u 
(View)

b	g to view Image
・	With Memory Card inserted, Memory 

card prior or Digital camera prior is 
selectable.

・	Saved media files are shown. Edit save 
location settings to switch between Phone/
Memory Card (fP.14-21).

・	Alternatively, open still image from Data 
Folder (fP.12-3).

Advanced

brP.7-13
●● Setting Captured Still Image as Wallpaper etc.
●● Playing Quick Play Image Slide Show

s

●● Select Quality (rP.14-20)
●● Set ISO (rP.14-20)
●● Set Exposure Metering (rP.14-20)
●● Select Effect (rP.14-20)
●● Activate/Cancel Auto Save (rP.14-21)
●● Set Save Location When Memory Card is Inserted 
(rP.14-21)

●● Show/Hide Guideline (rP.14-21)
●● Set Face Link Display (rP.14-21)
●● Set Shutter Sound (rP.14-21)
●● Set Timer Sound (rP.14-21)



Cam
era &

 Im
aging

7-9

7

Video

Record clips easily. Files are saved in 3GP format 
to Video folder in Data Folder. When recording 
a video to attach or insert into an S! Mail, set 
Shooting size to S! Mail (fP.7-13).

Using Display as Viewfinder

Video Viewfinder

m

a b c d e

f

g

h

i

j

lk

a Mode
 : Video

b Size

 : QVGA (320×240)*

 : QCIF (176×144)

 : SQCIF (128×96)

 : S! Mail (176×144)

 : S! Mail (128×96)

c Focus
 : AF On

 : Macro

 : AF Off

d Timer

 : Off	  : 3 sec.  

 : 5 sec.	  : 10 sec.

e Battery level

f Quality
 : Superfine

 : Fine

 : Normal

g White balance

 : Auto	  : Daylight 

 : Incandescent	  : Fluorescent 

 : Cloudy

h Sound

 : On

 : Off

i Focus frame

j Elapsed recording time/Available recording 
time
・	 If Size is set to S! Mail, only the elapsed 

recording time appears.

k Progress bar

l Expected video size/Available memory at the 
time you started the shooting
・	 If Size is set to S! Mail, the shooting data 

size/available shooting size appear.

m Save to

 : Phone

 : Memory Card prior

*Only for Landscape view

・	Pressing j shows or hides icons/the current 
settings.
・	If recorded video size is too big or memory is 
insufficient, recording ends before maximum 
recording time is reached.

Shooting Mode Description

Video
Record video suitable 
for attaching to S! Mail 
or saving to handset.
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Recording Video

Press i Set Shooting Mode
 and press u(Back)

Save automatically or
manually depending on 

Auto save settings (fP.14-24)

Press f(           )

・	 Adjusting size and brightness are available for video.

・	 Attach recorded video to message (fP.7-13).

・	 When Focus is set to AF On, Auto Focus is available; automatically focusing a subject at the center of AF frame (white) (the focus is locked while recording a 
video). 

・	 If video file is encoded beyond 15 FPS, it may not be played properly.
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Video Mode

Record up to an hour for one clip.

a	f → Camera → Video camera
・	Adjust settings before capturing as required 

(fP.7-14).

b	Frame image in Viewfinder
・	Use r / n / b to zoom in/out.

・	Use g to adjust brightness.

c	f ( )
・	To pause while recording, press u 

(Pause). To resume the recording, press u 
(Resume).

d	f (Stop)
・	When Focus is set to AF On, a subject is 

automatically focused on.

・	Video is saved automatically. When 
recordable time has elapsed, recording 
automatically ends.

・	Set Auto save to Off to save manually 
(fP.14-21).

Viewing Recorded Video (Quick Play)

a	f → Camera → Video camera → 
u (View)

b	 s to highlight video → f (Play)
・	Alternatively, check video from Data Folder 

(fP.12-3).

Advanced

brP.7-14
●● Using Recorded Video as Ringtone

s
●● 	Select Quality (rP.14-21)
●● Set Effect (rP.14-21)
●● Set Sound Recording (rP.14-21)
●● Activate/Cancel Auto Save (rP.14-21)
●● 	Set Save Location (rP.14-21)
●● 	Show/Hide Guideline (rP.14-21)
●● Set Shutter Sound (rP.14-21)
●● Set Timer Sound (rP.14-21)

Editing Still Images

Set image brightness, size and effect.

a	f → Data Folder → Select a 
folder

b	Select a file
・	If confirmation appears, select OK.

c	i → Edit → Image editor

d	Edit image

■	 To Set Effects on Image
i → Effect → Filter, Style or Warp → 
Select an effect → Select preview image → 
f (OK)
・	For some effects, adjust the effect level.

■	 To Adjust an Image Automatically
i → Adjust → Auto level

■	 To Adjust an Image
i → Adjust → Brightness, Contrast or 
Color → Adjust image → f (OK)

■	 To Resize an Image
i → Transform → Resize → Select a 
size
・	After selecting Customize, enter Width 

and Height, press f (OK).

■	 To Rotate an Image
i → Transform → Rotate → u 
( ) / i ( ) → f (OK)

■	 To Flip an Image
i → Transform → Flip → u ( ) / 
i ( ) → f (OK)
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■	 To Crop an Image
i → Transform → Crop → s to move 
crop frame to the position → u (Size)
→ s to adjust its size → f (OK)

・	To undo, press u (Undo).

e	f (Save) → Yes → Enter file name

Photo Library

Photo Album

View JPEG still images in handset or Memory Card. 

a	f → Camera → Photo album

b	Select a folder

c	g to view file

・	Some files may not appear.
・	Press f (Zoom) to enlarge image. To go back to 

normal view, press f (OK) / c.

Creating Flash®

Use a still image in Data Folder to create Flash® 
image. Attach created Flash® image to sent via 
message.

a	f → Camera → Dynamic effect

・	With Memory Card inserted, select a file 
from Pictures or Digital camera folder.

b	Select file → Create Flash®

■	 To Add Frame to Image
 (Frame) → Select frame type 

→ Select a frame ( → u (Done) / f (OK))

■	 To Add Icon to Image
 (Icon) → (to add icon, i → Insert → )

Select icon → Adjust the position → f (OK)

■	 To Add Balloon to Image
 (Balloon) → (to add balloon, i → 

Insert → ) Template/Preset → Select 
balloon → Adjust the position (if Template 
is selected, enter text → Adjust the position) 
→ f (OK)
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Advanced Settings

Capturing Still Images/Recording Video

Setting Capture Method
In Viewfinder, i

■	To Set Capturing Size
Size → Select item

■	To Set Macro
Focus → Macro

■	To Set Time
Timer → Select item

■	To Set White Balance
White balance → Select item

■	To Set Effect (Color Tone)
Settings → Effect → Select item

■	To Set Sound Recording
Settings → Sound recording → On or Off
・	 Recording setting is only for Video.

Sending Captured Still Images/Recorded Video
After capturing, u (Send)

・	 For video, after recording, i → Send.

・	 To operate above, set Auto save to Off or On 
(Preview manual) (fP.14-21).

■	To Send via Message
Via message → (fP.4-4 S! Mail b)

■	To Send via Infrared
Via infrared (fP.13-3)

Capturing Still Images

Setting Captured Still Image as Wallpaper etc.
After capturing still image, i → Set as
・	 To operate above, set Auto save to Off or On 

(Preview manual) (fP.14-21).

■	To Set Image to Wallpaper
Wallpaper → Operate the following as required: 

u (Rotate) several time to adjust directions

Or

n / b to adjust size → f (Set)

■	To Set Image to Incoming Image
Caller ID → Search and select Phone Book 
entry (fP.2-14) → f (Set)

■	To Set Image to Alternative Picture
Still image → f (Set)

Editing Face Link
After capturing still image, i → Edit face link 
→ Search and select entry (fP.2-14)

・	 Before capturing, set Face link display to On.

■	 To Restore Currently Edited Image
 (Reset) → Yes

c	u (Save) → Enter name

・	To delete frame added to image, select a file → 
 (Frame) → None.

・	To delete icon, select file → Select (Icon) → 
i → Delete → Use g to highlight icon → 
f (Delete).

・	To delete balloon, select file → Select  (Balloon) 
→ i → Delete → Use g to highlight icon → 
f (Delete). 
・	To create Flash® using an image in Data Folder, 

highlight an image → i → Edit → Dynamic 
effect and perform the same operations.

Advanced

brP.7-15
●● Switching Folder
●● Setting Opened Still Image as Wallpaper, etc.
●● Sending Opened Still Image
●● Editing Opened Still Image
●● Saving Tag Information
●● Deleting Opened File
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Recording Videos

Viewing Recorded Video before Saving
After recording video, u (Play)

・	 To operate the above, set Auto save to Off (fP.14-21).

Using Recorded Video as Ringtone
After recording video, i → Set as
・	 To operate the above, set Auto save to Off (fP.14-21).

■	To Set Video to Voice Ringtone
Voice ringtone

■	To Set Video to Video Ringtone
Video ringtone

■	To Set Video to Caller Ringtone
Caller ringtone → Search and select Phone 
Book entry (fP.2-14)

Quick Play

Editing/Setting/Sending Still image

f → Camera → Camera → u (View) → g to 
view still image

■	To Send Still Image
u (Send)

・	 To Send via Message
	 Via message → (fP.4-4 S! Mail b)

・	 To Send via Infrared
	 Via infrared (fP.13-3)

■	To Use Quick Play Still Image as Wallpaper, 
etc.
i → Set as
・	 To Set Image as Wallpaper
	 Wallpaper → Operate the following as 

required: u (Rotate) several time to adjust 
directions

	 Or
	 n / b to adjust size → f (Set)

・	 To Set Image as Incoming Image
	 Caller ID → Search and select Phone Book 

entry (fP.2-14) → f (Set)
・	 To Set Image as Alternative Picture
	 Still image → f (Set)

■	To Edit Still Image
i → Edit → Image editor → (fP.7-11 Editing 
Still Images d)

■	To View Still Image Details
i → Details

■ To Delete Still Image
Highlight image → i → Delete → Yes

Editing/Setting/Sending Video

f → Camera → Video camera → u (View) → 
s to view video

■	To Send Video
i → Send
・	 To Send via Message
	 Via message → (fP.4-4 S! Mail b)

・	 To Send via Infrared
	 Via infrared (fP.13-3)

■	To Set Video as Ringtone
i → Set as
・	 To Set Video as Voice Ringtone
	 Voice ringtone
・	 To Set Video as Video Ringtone
	 Video ringtone
・	 To Set Video as Caller Ringtone
	 Caller ringtone → Search and select Phone 

Book entry (fP.2-14)

■	To View Video Details
i → Details

■	To Delete Video
・	 To Delete a Image
	 Highlight video → i → Delete → Selected 

→ Yes
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Photo Library

Changing Still Image Display

f → Camera → Photo album → u (Category) 
→ Folder/Month/Date/Tags/Faces

Switching Folder

f → Camera → Photo album → i → 
Memory switch → Phone+Memory card/Phone/
Memory card/Digital camera
・ When Memory Card inserted, Phone+Memory 

card/Phone/Memory card are selectable.

Setting Opened Still Image as Wallpaper, etc.

f → Camera → Photo album → Select a file 
location → Select a file → i → Set as

■	To Set Image to Wallpaper
Wallpaper → Operate the following as required:
u (Rotate) several times as required to adjust 
directions

Or

n / b to adjust size → f (Set)

■	To Set Image to Incoming Image
Caller ID → Search and select Phone Book 
entry (fP.2-14) → f (Set)

■	To Set Image to Alternative Picture
Still image → f (Set)

Sending Opened Still Image

f → Camera → Photo album → Select a file 
location → g to view image → u (Send)

■	To Send via Message
Via message → (fP.4-4 S! Mail b)

■	To Send via Infrared
Via infrared (fP.13-3)

Editing Opened Still Image

f → Camera → Photo album → Select a file 
location → g to view image → i → Edit → 
Image editor → (fP.7-11 Editing Still Images d)

Saving Tag Information

f → Camera → Photo album → Select file 
location → g to view image → i → Manage 
tags

■	To Save Existent Tag
Select tag

■	To Save New Tag
u (New) → Enter tag name → f (OK) → 
Select new tag

Deleting Opened File

f → Camera → Photo album → g to view 
image → Select a file → i → Delete → Yes

・	 To Delete Multiple Images
	 i → Delete → Multiple → Check videos → 

u (Delete) → Yes
・	 To Delete All Images
	 i → Delete → All → Enter Phone Password 

→ f (OK) → Yes

Playing Quick Play Image Slide Show

f → Camera → Camera → u (View) → i 
→ Slide show
・	 Press f (Pause) during playback to pause Slide 

show. Press f (Restart) to replay Slide show.
・	 Press u (Stop) to cancel Slide show.

Exiting Quick Play
c during Quick Play
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Adding Icon after Adjusting

f → Camera → Dynamic effect → Select file 
→  (Icon) → Select icon → i

■	To Zoom in/out
Zoom → r to adjust size → f (OK) → Adjust 
position → f (OK)

■	To Rotate Icon
Rotate → g to adjust angle → f (OK) → 
Adjust position → f (OK)

■	To Reverse Icon
Reverse → s → f (OK) → Adjust position 
→ f (OK)

■	To Transparentize Icon
Transparency → r to adjust transparency 
→ f (OK) → Adjust position → f (OK)

Editing Text on Balloon

f → Camera → Dynamic effect → Select file 
→  (Balloon) → Template → Enter text → i

■	To Change Text Size
Font size → r to adjust size → f (OK) → 
Adjust position → f (OK)

■	To Change Text Color
Font color → g to highlight text color
→ f (OK) → Adjust position → f (OK)

■	To Assign Motion
Action text → g to highlight action → f 
(OK) → Adjust position → f (OK)

■	To Reserve Balloon 
Reverse → s → f (OK) → Adjust position
→ f (OK)

■	To Edit Text
Edit text → Edit text → f (OK) → Adjust 
position → f (OK)

Editing Placed Icon 

Place icon (fP.7-12) →  (Icon) → g to highlight 
icon → f (Edit)

■	To Adjust Position
Adjust position → Adjust position → f (OK)
→ u (Done)

■	To Zoom in/out
Zoom → r to adjust size → f (OK) → u 
(Done)

■	To Rotate Icon
Rotate → g to adjust direction → f (OK) → 
u (Done)

■	To Reverse Icon
Reverse → s → f (OK) → u (Done)

■	To Transparentize Icon
Transparency → r to adjust transparency → 
f (OK) → u (Done)

Editing Placed Balloon

Place balloon (fP.7-12) →  (Balloon) → g to 
highlight Balloon → f (Edit)

■	To Edit Text
Edit text → Edit text → u (Done)

■	To Change Balloon Type
Balloon type → Select Balloon → u (Done)

■	To Adjust Position
Adjust position → To adjust position → f 
(OK) → u (Done)

■	To Change Text size
Font size → r to adjust size → f (OK) → 
u (Done)

■	To Change Text Color
Font color → g to highlight text color
→ f (OK) → u (Done)

■	To Assign Motion 
Action text → g to highlight action → f 
(OK) → u (Done)

■	To Reserve Balloon
Reverse → s → f (OK) → u (Done)

Previewing Flash®

In Create Flash® window, i (Preview)
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